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         Introduction

         W elcome to Word 2003 For Dummies, the book that explodes the myths and renders sane the madness of Microsoft’s latest and greatest word processor, for the year 2003 and beyond.

         Word is impressive and often imposing. More than just a word processor, Word is capable of putting down on the page just about anything. Do you need to know all that stuff?

         No! You probably don’t even want to know everything that Word can do. You just want to know the basics, or some handy tricks, or read about some insight into the program so that you can hurry back to your work — and hopefully not be terrified in the process. If that’s you, you’ve found your book.

         This book informs and entertains. It has a serious attitude problem. After all, you don’t need to love Word to use Word. It’s a tool. While some mechanics may love their Snap-on‰ tools, they just tools. So instead of hype, be prepared to read some informative, down-to-earth explanations — in English — of how to get the job done with Microsoft Word. You take your work seriously, but you definitely don’t need to take Word seriously.

         
            About This Book

            I don’t intend for you to read this book from cover to cover. It’s not a novel, and if it were, I’d kill off all the characters at the end, so there would be no chance for a sequel (let alone a trilogy) and then no one would want to publish it anyway.

            No, this book is a reference. Each chapter covers a specific topic or task that Word does. Within a chapter, you find self-contained sections, each of which describes how to perform a specific task or get something done. Sample sections you encounter in this book include

            
               	[image: bullet]	Saving your stuff

               	[image: bullet]	Cutting and pasting a block

               	[image: bullet]	Quickly finding your place

               	[image: bullet]	Aligning paragraphs

               	[image: bullet]	Cobbling a table together quickly

               	[image: bullet]	Opening a document for repair

               	[image: bullet]	Using a document template

            

            There are no keys to memorize, no secret codes, no tricks, no videos to sleep by, and no wall charts. Instead, each section explains a topic as though it’s the first thing you read in this book. Nothing is assumed, and everything is cross-referenced. Technical terms and topics, when they come up, are neatly shoved to the side, where you can easily avoid reading them. The idea here isn’t for you to learn anything. This book’s philosophy is to help you look it up, figure it out, and get back to work.

         

         
            How to Use This Book

            This book is a doing book. It’s about getting things done in Word and the only assumption made is that you know what you want to do or at least you have a general or even vague idea. That’s fine in this book; nothing is assumed so you’ll never be utterly confused.

            Word uses the mouse and menus to get things done, which is what you would expect from Windows. Yet there are times when various key combinations, several keys you may press together or in sequence, are required.

            This is a keyboard shortcut:

            
               Ctrl+Shift+P

            

            This shortcut means that you should press and hold Ctrl and Shift together, press the P key, and then release all three keys.

            Menu commands are listed like this:

            
               File⇒Open

            

            This command means that you open the File menu (with the mouse or the keyboard — it’s your choice) and then choose the Open command. You may see underlined letters on your menus; these letters represent “hot keys” used in Windows. You can press the Alt+F key combination to access the F in File and then the O (or Alt+O) to access the O in Open.

            Note that in Windows, you may have to press the Alt key first (by itself) to activate the menu hot keys. Then you can use the hot keys to access menu and dialog box commands.

            If I describe a message or something you see onscreen, it looks like this:

            

            
               Cannot find hard drive, save elsewhere?
            

            If you need further help operating your computer or a good general reference, I can recommend my book PCs For Dummies, published by Wiley Publishing, Inc. The book contains lots of useful information to supplement what you’ll find in this book.

         

         
            What You’re Not to Read

            Special technical sections dot this book like lemon pepper on Aunt Winnie’s fried chicken. They offer annoyingly endless and technical explanations, descriptions of advanced topics, or alternative commands that you really don’t need to know about. Each one of them is flagged with a special icon or enclosed in an electrified, barbed wire and poison ivy box (an idea I stole from the Terwilliker Piano Method books). Reading this stuff is optional.

         

         
            Foolish Assumptions

            Here are my assumptions about you. You use a computer. You use Windows, specifically Windows 2000 or Windows XP (Professional or Home). The Word 2003 product does not run on any other version of Windows (at least as this book goes to press). There are no specific issues between Word and Windows as far as this book is concerned.

            Your word processor is Microsoft Word 2003, which may have come with your computer, or you may have purchased it separately either by itself or as part of the Microsoft Office 2003 suite of applications. Whatever. I refer to the program as “Word” throughout this book.

            The program covered here is not Microsoft Works. That is a separate program sold by Microsoft; this book does not cover Works at all.

            I do not assume that you have Microsoft Office installed. This book does not cover using Office or any of the other Office applications.

            Finally, this book assumes that you’re running Word with the personalized menu system switched off. To confirm this, follow these steps inside the Word 2003 program:

            
               
                  	1.	Choose Tools
                  ⇒Customize from the Menu bar.

               		This causes the Customize dialog box to appear.

               
                  	2.	Click the mouse on the Options tab in the Customize dialog box.

               
                  	3.	Click to put a check mark by the item that reads, “Always show full menus.”

               
                  	4.	Click the OK button.

            

            By marking this setting, Word displays the full menus every time you access a menu command. Otherwise, you may not see all the commands on the menus, which can be frustrating.

         

         
            How This Book Is Organized

            This book contains six major parts, each of which is divided into several chapters. The chapters themselves have been sliced into smaller, modular sections. You can pick up the book and read any section without necessarily knowing what has already been covered in the rest of the book. Start anywhere.

            Here is a breakdown of the parts and what you can find in them:

            
               Part I: Hello, Word!

               This part covers basic word processing, from entering text to saving a document, search and replace, spell-checking, working with blocks, and printing.

            

            
               Part II: Letting Word Do the Formatting Work

               This part deals with formatting, from the smallest iota of text to formatting commands that span an entire document and more.

            

            
               Part III: Sprucing Up Your Document

               Beyond formatting, this part of the book covers additional things you can do with Word to make your document really stand out. Covered here are many of the intermediate-level features most users never bother with in Word.

            

            
               Part IV: Land of the Fun and Strange

               This part covers some general and miscellaneous topics, items that others might consider to be too borderline bizarre to be found in a “beginners” book on Word.

            

            
               Part V: Creating Lotsa Stuff in Word

               This part presents a sample of Word’s potential. Each chapter outlines a special project you can do in Word by showing you step-by-step how to put things together.

            

            
               Part VI: The Part of Tens

               How about “The Ten Commandments of Word”? Or consider “Ten Truly Bizarre Things.” Or the handy “Ten Things Worth Remembering.” This section is a gold mine of tens.

            

         

         
            What’s Not Here

            This book can be only so big. The book’s author, on the other hand, can grow to immense size! To keep them both in check, I’ve created a companion Web page. This site covers issues that may arise after the book goes to press. It’s not to contain anything “missing” from the book; no, you have everything you need right in your eager, ready-to-type hands. The Web page is just to keep things up-to-date. That way, I can offer you supplemental information after the book goes to press.

            If you have Internet access and a Web browser, you can visit this book’s Web page at

            

            
               www.wambooli.com/help/word
            

            Additionally, I publish a free weekly newsletter that often contains tips, Q&A, shortcuts, and various lessons expanding the basic word processing knowledge presented here. Read more about my Weekly Wambooli Salad newsletter on this Web page:

            

            
               www.wambooli.com/newsletter/weekly
            

         

         
            Icons Used in This Book

            

            
               [image: Tip]
            

            	This icon flags useful, helpful tips or shortcuts.

            

            
               [image: Remember]
            

            	This icon marks a friendly reminder to do something.

            

            
               [image: Warning(bomb)]
            

            	This icon marks a friendly reminder not to do something.

            

            
               [image: TechnicalStuff]
            

            	This icon alerts you to overly nerdy information and technical discussions of the topic at hand. The information is optional reading, but it may enhance your reputation at cocktail parties if you repeat it.

         

         
            Where to Go from Here

            Start reading! Observe the table of contents and find something that interests you. Or look up your puzzle in the index.

            If you’re new to Word, start off with Chapter 1.

            If you’re an old hand at Word, consider checking out Part V for some  inspiration.

            Is Word broken? Fix it by checking out Chapter 29.

            Read! Write! Produce!

            By the way, I am available on the Internet if you need me. My e-mail address is dgookin@wambooli.com.

            I reply to all my e-mail, so drop a note if you feel like saying, “Hi,” or have a question about Word or this book. And don’t forget to stop by the book’s Web page, mentioned earlier in this Introduction.

            Enjoy the book. And enjoy Word. Or at least tolerate it.

         

      

      

   
      
         Part I

         Hello, Word!

         
            [image: ]
         

         In this part . . .

         
            Back in the cave man days, our ancestors Og and Gronk sat around and dreamt of the day when they could have a proper computer with efficient word processing software available for them to express their thoughts. Alas, there was nothing there but rocks. So, as Og carefully began to carve his thoughts into the cave wall with a rock, Gronk let loose a tremendous prehistoric belch and the cave collapsed.

         Don’t let your word processing attempts be so easily thwarted! Sure, we’ve come a long way from carving rocks and drawing on cave walls. The Ancient Egyptians gave us paper. The Phoenicians developed the alphabet. Gutenberg developed movable type. And the typewriter allowed those of us with utterly illegible handwriting to actually practice the art of writing without making the reader’s eyes cross.

         And now we have the word processor. It’s so commonplace that people forget about Egyptian papyrus and Gutenberg and that old typewriter. Words fling out magically and can be erased, moved, searched, saved, and printed with just a few deft flicks of the wrist. Don’t let a prehistoric Gronk stand in the way of your word processing wishes. Cut lose and enjoy these several chapters that cover the bare basic beginnings of your word processing odyssey.

         

      

   
      
         Chapter 1

         The Big Picture

         In This Chapter

         
            [image: bullet]	Starting Word

            [image: bullet]	Reading the Word screen

            [image: bullet]	Getting help from Word

            [image: bullet]	Using your keyboard

            [image: bullet]	Exiting Word (or not)

            
               
            

         

         
            It was the best of times, it was the worst of times.
         

         D on’t we all dream of becoming a famous novelist someday? Or how about writing that award-winning screenplay? Then there’s the less flashy: the reports, the memos, the notes jotted down, or that list of chores. It’s all words, mind you. From the note to the teacher to the first paragraph in this century’s first Great American Novel, it’s just words.

         
            
               Perhaps it was the most mediocre of times?

         

         The software best designed to work with words, prophetic or mundane, is a word processor such as Microsoft’s Word.

         
            
               Then again, let history frame the times. I’ve got a credit card, and by gum, I’m going to use it! 

         

         This chapter is your introduction to Microsoft Word. It provides the groundwork for you to use and understand how Word fits into your computing life, plus it may show you a few fancy things you might not expect. All the better to hurry you on your merry way toward writing whatever great things your brain is eager to produce.

         
            The Good, Best, and Worst Ways to Start Word

            
               
                  How do I start thee, Word? Let me count the ways. . . .

            

            Anyone using a computer suspects that there is probably a better, faster, or more serious way to get things done. There are so many  Who knows when someone will amble up to you and giggle at how you start your word processor. “You do that?” they’ll snicker. Oh, no. What now?

            Don’t fret! There are more ways to start a program on your computer than there are ways intoxicated monkeys could wreck an antique store. What’s certain, however, is that there is no point wasting time showing you everything. Instead, how about if I just illustrate the typical, better, and best ways of starting Word? (The worst ways can be found in another book by some other author.)

            First, some basic steps you need to take no matter what:

            
               
                  	1.	Ensure that your computer is on and toasty.

               		Any computer that’s on is, in fact, toasty. The only way to make it toastier is to actually insert bread, which I don’t recommend.

               
                  	2.	Prepare yourself physically.

               		Make sure you’re seated, with a nice, upright, firm posture. They tell me that your wrists should be even with your elbows and that you shouldn’t have to tilt your head forward. Shoulders relaxed.

               		Crack your knuckles. Are your fingers ready to dance on the keyboard? Good!

               
                  	3.	Prepare yourself mentally.

               		Close your eyes. Unwind. Breathe in, breath out. Think of calm, blue waters. Prepare to let your thoughts flow into the computer. Remember, you are the master. Mutter that over and over: I am the master. . . .

            

            

            
               [image: Tip]
            

            	If you need help starting your computer, refer to my book PCs For Dummies for quick and accurate turning-on-the-computer instructions.

            You can stop muttering “I am the master” now.

            
               A humble, yet unimaginative way to start Word

               Without fail, the place to start any program in Windows is at the fabled Start button. It may not be the coolest way to start a program, but it’s consistent and reliable — good things to have in a computer. Obey these steps:

               
                  	

               

               
                  [image: ]
               

               
                  
                     	1.	Click the Start button.

                  		Use your computer mouse to click the Start button, which is often found on the left side of the taskbar, at the bottom of the screen.

                  		Clicking the Start button displays the Start menu.

                  
                     	2.	Choose All Programs
                     ⇒Microsoft Word, or it could be as long as All Programs
                     ⇒Microsoft Office
                     ⇒Microsoft Office Word 2003

                  		The menu may just read “Programs” instead of “All Programs.”

                  		Look at Figure 1-1. Note that the menu item may say Word or Microsoft Word or even Microsoft Word 2003.

               

               
                  
                     
                        
                           	
                              
                                 Figure 1-1: Locating Word on  the All Programs menu.

                           
                           	
                              [image: Figure 1-1: Locating Word on the All Programs menu.]
                           
                        

                     
                  

               

               Watch in amazement as your computer whizzes and whirs. Before too long, Word appears on the computer’s monitor, trying to be as friendly, inviting, and fun as the cockpit of a jet fighter.

               Don’t let Word’s appearance overwhelm you! I discuss what you’re looking at in the section, “Word on the Screen,” later in this chapter.

            

         [image: TechnicalStuff]
            
               Automatically starting Word every ding-dong time you start Windows

               To get your computer to start Word whenever you start Windows, locate the Microsoft Word item on the All Programs menu (from the Start menu). Use your mouse to drag that menu item up and into the Startup submenu, which automatically opens to accept Word as a new entry. This shuffles the Word menu item into the Startup folder, from which it will automatically run every time you begin your Windows session.

               If you make a mistake, press Ctrl+Z (the “undo” key) and try again. Or if this maneuver seems beyond your skills, have your computer expert or guru manage the task for you.

            

            
               My favorite way to start Word

               	

               
                  [image: ]
               

               	My favorite way to run Word is by opening a shortcut icon pasted to the desktop or by clicking a button on the Quick Launch bar. Both ways are more direct than using the silly Start menu, and the Quick Launch bar method is the fastest because you need to click the button only once to start Word.

               Whether you’re pasting a Word shortcut icon to the desktop or to the Quick Launch bar, the first step is the same: to create the Word shortcut icon. This can be a little technical, so put on your Paying Attention cap as you follow these steps:

               
                  
                     	1.	Locate the Start menu’s Microsoft Word menu item.

                  		Don’t start Word now! Just point the mouse at the Microsoft Word menu item, shown in Figure 1-1.

                  	
                     2.	Right-click the Microsoft Word menu item.

                  		A pop-up menu appears.

                  	
                     3.	Choose Send To
                     ⇒Desktop (Create Shortcut).

                  		There. You’ve just created a Word shortcut icon on the desktop. That was too cinchy! To prove it:

                  	
                     4.	Click the mouse on the desktop.

                  		The desktop is the background you see when you use Windows. Clicking the desktop hides the Start menu.

                  	
                     5.	Locate the Microsoft Word shortcut icon.

                  		It looks like the figure shown in the margin at the start of this section; the blue W in a square icon, with “Microsoft Word” displayed beneath. That’s your shortcut to Word.

               

               You can now use the shortcut icon to start Word without having to mess with the Start menu.

               If you’d rather have Word on the Quick Launch bar, drag and drop the shortcut icon down there: Use your mouse to drag the Word icon to the Quick Launch bar, and then release the mouse button to “drop” the icon, as shown in Figure 1-2. (You may need to resize the Quick Launch bar to see the Word icon; refer to PCs For Dummies for more information on the Quick Launch bar.) Now, Word is only one quick click away from in-your-face word processing.

               
                  
                     
                        
                           	
                              
                                 Figure 1-2: Putting Word on  the Quick Launch bar.

                           
                           	
                              [image: Figure 1-2: Putting Word on the Quick Launch bar.]
                           
                        

                     
                  

               

            

            
               Starting Word by opening a document

               	

               
                  [image: ]
               

               	You use Word to create documents. These are like paper documents, but on the computer they’re stored as files. These files appear as happy little graphical icons on the screen. Any time you spy a Word document icon, you can double-click it with the mouse to start up Word and open that document for editing. Here’s how such a thing might happen:

               
                  
                     	1.	Open the My Documents folder.

                  	

               

               
                  [image: ]
               

               
                  		The My Documents folder is where Word, as well as other applications, stores the stuff you create. You can find this folder on the desktop or possibly in the main Start menu: Point the mouse at the folder and click twice to open it.

                  
                     	2.	Locate a Word document.

                  		Word documents appear as a document icon with a blue W to one side, as shown in the margin at the start of this section.

                  
                     	3.	Double-click the Word document icon.

                  		This opens the document, starts Word, and loads the document for editing, reading, modifying, perusing, cussing, mangling, and potentially fouling up beyond all recognition.

               

               You can open any Word document by following these steps. The document can be on the desktop, in the My Documents folder, or in any other folder or any location where a Word document icon can lurk.

               
                  	[image: bullet]	The document name appears below the icon. You can use the name to determine the document’s contents — providing that the document was properly named when it was saved to disk. More on that later.

                  	[image: bullet]	If you have one document you open consistently, consider putting a shortcut to that document on the desktop for quick access: Right-click the document’s icon and choose Send To⇒Desktop (Create Shortcut).

               

               

               
                  [image: Tip]
               

               
                  		[image: bullet]	You can see a list of the recent documents you’ve worked on by choosing the My Recent Documents menu from the main Start menu: Click the Start button and then look for the My Recent Documents list. (Some versions of Windows may merely say Document.) Choose your document from that list to open it.

               

               

               
                  [image: TechnicalStuff]
               

               
                  		[image: bullet]	Some Word documents will appear with .doc at the end of the name. This is the filename extension, and displaying that .doc part of the filename is optional. Depending on how you’ve configured Windows, you may or may not see the .doc part of the name.

               

            

         

         
            Word on the Screen

            Right after starting Word, I prefer to maximize. That doesn’t mean that I sit down and stuff myself with pizza. No, maximizing is a Windows trick you can pull to increase the amount of screen real estate Word uses.

            	

            
               [image: ]
            

            	To run Word in full-screen mode, click the Maximize button (the middle one) in the upper-right corner of the window. This button maximizes Word to fill the entire screen. If Word is already maximized, two overlapping boxes appear on the button; you don’t need to click anything in that case.

            Now that you can see Word long and tall on the screen, follow along with this text and Figure 1-3 to locate the many fresh and exciting items on the typical blank Word screen.

            
               
                  
                     
                        	
                           
                              Figure 1-3: Word in all its basic, naked glory.

                        
                        	
                           [image: Figure 1-3: Word in all its basic, naked glory.]
                        
                     

                  
               

            

            
               Gizmos and gadgets

               Word’s goal is to help you write. Well, perhaps not write in the sense that Charles Dickens or Jane Austen writes. No, it’s actually the processing of words that Word does best. That’s why the largest portion of the Word screen is for composing text (refer to Figure 1-3).

               Surrounding the text-composing area are various bells, whistles, switches, and doodads that would be interesting only if they were edible. And the good news is that with Word, all that stuff is totally customizable by you (better know what it all means before you go changing everything):

               
                  	[image: bullet]	The title bar, which lists the document’s title, or merely Document 1 until you give the document a title by saving it to disk.

                  	[image: bullet]	The menu bar, which contains a full list of Word’s various and sundry commands.

                  	[image: bullet]	The Standard and Formatting toolbars, which are on top of each other in Figure 1-3, although they occasionally (and annoyingly) appear on the same row. (You can rearrange them at your whim.)

                  	[image: bullet]	The ruler, which helps with setting margins and tabs.

                  	[image: bullet]	The task pane, which lists commands or options relevant to whatever you’re doing in Word.

               

               Below the writing area are two items:

               
                  	[image: bullet]	The View buttons, located to the left of the horizontal scroll bar, control how your document is displayed.

                  	[image: bullet]	The status bar dishes up lots of trivia about your document, some of which is interesting.

               

               What each of these various buttons, bars, and menus does — and whether it’s important — is covered elsewhere in this book. Right now, you just need to know the names of things so that you don’t get lost later.

               

               
                  [image: Remember]
               

               
                  		[image: bullet]	Most of this stuff is customizable. And not only can you change and rearrange Word’s options to suit you, you can make most of the stuff you see on the screen go away so that you see only the blank part where you write.

                  	[image: bullet]	Typically most folks don’t change anything. Alas. 

                  	[image: bullet]	The status bar is not a yuppie hangout. It contains cubbyholes in which random and often cryptic information is displayed. This book explains when the information is useful to you.

                  	[image: bullet]	Figure 1-3 shows Word in Print Layout view. If it looks different on your screen, choose View⇒Print Layout from the menu. (Some people prefer to use Word in Normal view.)

               

               

               
                  [image: Tip]
               

               
                  		[image: bullet]	If you want the Standard and Formatting toolbars to appear on separate rows, click the down-pointing arrow at the end of either toolbar. That displays a drop-down menu, from which you can choose the command Show Buttons on Two Rows. That fixes things.

                  	[image: bullet]	The task pane may not show up until it’s needed or until you use specific commands in Word. Choose View⇒Task Pane to show or hide the task pane.

                  	[image: bullet]	The Windows taskbar, located at the bottom of the screen, is a part of Windows itself and not Word. However, as you open documents in Word, buttons representing those documents appear on the Windows taskbar.

                  	[image: bullet]	Notice the mouse pointer in Figure 1-3? It’s the insertion pointer, shaped like an I-beam. That’s the way the mouse pointer appears when it’s sliding over your document in Word. The I-beam means “I beam the insertion pointer to this spot when you click the mouse.”

                  	[image: bullet]	The lines next to (or beneath) the insertion pointer are part of Word’s click-and-type feature. Using click-and-type is covered in Chapter 18, in the section that discusses automatic formatting as it happens.

               

               

               
                  [image: Tip]
               

               
                  		[image: bullet]	You can use the mouse to see what some of the little buttons and things with pictures on them do in Word. Just hover the mouse pointer over the button, and — voilà! — it’s like Folgers Instant Information Crystals.

                  	[image: bullet]	If you don’t actually see the Standard or Formatting toolbars or the ruler, or you want to change the way the Word screen looks right now, hop on over to Chapter 28 on modifying Word’s appearance.

               

            

            
               The blank place where you write

               After Word starts, you’re faced with the electronic equivalent of The Blank Page, the same concept that induced mind-numbing writer’s block in generations of writers. It makes you wonder if ancient Egyptian scribes ever experienced “papyrus block.”

               The key to writing in Word is to look for the blinking toothpick cursor — a blinking bar in your text that shows you where your typing will appear on the screen:

               
                  Choose View
                  ⇒Normal from the menu.

               In Normal view, more of the screen is devoted to writing text. However, in this view, a horizontal line appears on the screen, just below the blinking toothpick cursor. That’s that the End-of-Text marker. Consider it the steel beam that supports your text, keeping it from harm’s way, in the evil nothingness that exists below your text:

               
                  Choose View
                  ⇒Print Layout from the menu.

               In Print Layout view, the End-of-Text marker disappears. Unlike in Normal view, the focus here is how the words look on the page. Personally, I prefer to write in Normal view and then switch to Print Layout for formatting and editing.

               
                  	[image: bullet]	Writing (or typing, depending on how good you are) is covered in the next chapter. That would be Chapter 2.

                  	[image: bullet]	Any weird stuff you see onscreen (a ¶, for example) is a Word secret symbol. Chapter 2 tells you why you may want to view those secret symbols and how to hide them if they annoy you.

                  	[image: bullet]	The cursor shows the exact spot where text appears. The cursor is also called an insertion pointer because traditional computer cursors are underlines that slide under what you type. I prefer the term toothpick cursor because insertion pointer is just too medically geometric for my tastes. Characters you type appear immediately to the left of where the toothpick cursor is flashing, and then the cursor moves forward and waits for the next character.

               

            

         

         
            Word’s Feeble Attempts to Help You

            There are many ways to get help from Word, most of which are covered in Chapter 2. For now, on the screen, you may see two places to get help.

            First, there’s the Ask a Question box, which is located on the right end of the menu bar, as shown in Figure 1-4. You click the mouse in that space, and then type a question or keyword. Be cryptic when you type; pretend that you’re a robot. So instead of typing in “Tell me how to format this paragraph?” type in “formatting paragraphs.” Press the Enter key. Word displays helpful information in the task pane.

            
               
                  
                     
                        	
                           
                              Figure 1-4: The Ask a Question box.

                        
                        	
                           [image: Figure 1-4: The Ask a Question box.]
                        
                     

                  
               

            

            Second, and more interesting than the Ask a Question box, is the Office Assistant.

            If the Office Assistant isn’t visible on the screen, choose Help⇒Show the Office Assistant from the menu. What appears is a helpful character, normally an animated paper clip with bulging eyes, but you can change the character to something else if you like (I tell you how in Chapter 2). The paperclip Office Assistant, officially known as Clippit, is shown in Figure 1-5.

            
               
                  
                     
                        	
                           
                              Figure 1-5: The paper clip.

                        
                        	
                           [image: Figure 1-5: The paper clip.]
                        
                     

                  
               

            

            The Office Assistant is there to help you. Most of the time, however, it just sits there watching while you type or getting bored while you rummage for a thought.

            Here are my Office Assistant musings:

            
               	[image: bullet]	You can move the Office Assistant around by dragging it with the mouse. I put my assistant down in the lower-right corner of the screen, where he won’t get into any trouble.

               	[image: bullet]	Right-click the Office Assistant to see a list of its menu options. My favorite menu item is Animate, which makes the Office Assistant do something interesting.

               	[image: bullet]	You can choose from among a host of Office Assistants: Right-click the Office Assistant and choose the Choose Assistant item from the pop-up menu. My favorite assistant is the dog, though I’m also fond of Merlin.

               	[image: bullet]	If you detest the Office Assistant, right-click on his nose and choose the Hide menu option. Hey, the screen is crowded enough!

               	[image: bullet]	The Office Assistant hides when you switch from Word to other  applications.

               	[image: bullet]	Using the Office Assistant to get help is covered in Chapter 2.

            

         

         
            A Look at Your Keyboard

            The shortest distance between your brain and a Word document is down your arms and through your fingers onto the computer keyboard. You’ll use the keyboard not only for typing text, but also for editing your text and using various commands that spiff up what you write.

            Figure 1-6 shows the typical PC keyboard used during the turn of the century (the turn from the 20th to the 21st century, not from the 19th to the 20th century, when “keyboard” typically implied a piano.)

            Notice how the keyboard is divided into separate areas, each of which has a special function? In Word, you use the keys in these groups either alone or in combination with other keys:

            
               	[image: bullet]	Function keys: These keys are located along the top row of the keyboard, labeled F1 through F12. You can use them alone or in cahoots with the Ctrl, Alt, and Shift keys.

               	[image: bullet]	Typewriter keys: These are the standard alphanumeric keys you find on any typewriter: A through Z, 1 through 0, plus symbols and other exotic characters.

               	[image: bullet]	Cursor keys: These arrow keys move the toothpick cursor around the screen. Also lumped in are the Home, End, PgUp (or Page Up), PgDn (or Page Down), Insert, and Delete keys. Oh, and the big plus and minus keys on the number pad are counted as well.

               	[image: bullet]	Mon key: A derogatory term for a primate or ape.

               	[image: bullet]	Numeric keypad: These keys toggle (meaning that they can’t make up their minds) between cursor keys and number keys. The split personality is evident on each key cap, which displays two symbols. The Num Lock key and its corresponding light are on if the numeric keypad (1, 2, 3) is active. If the cursor keys (arrows, Home) are active, Num Lock is off.

               	[image: bullet]	Shift keys: These keys don’t do anything by themselves. Instead, the Shift, Ctrl, and Alt keys work in combination with other keys.

            

            
               
                  
                     
                        	
                           
                              Figure 1-6: Famous attractions on the typical PC keyboard.
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            Here are some individual keys worth noting:

            
               	[image: bullet]	Enter: Marked with the word Enter and sometimes a cryptic, curved arrow-thing: ↵. You use the Enter key to end a paragraph of text.

               	[image: bullet]	Esc: The “escape” key doesn’t really do anything in Word; however, in a dialog box pressing the Esc key is the same as clicking the Cancel button with the mouse.

               	[image: bullet]	Spacebar: The only key with no symbol; inserts spaces between the words.

               	[image: bullet]	Tab: Inserts the tab “character,” which shoves the next text you type over to the next tab stop. An interesting and potentially frustrating formatting key (but nicely covered in Chapter 13).

               	[image: bullet]	Backspace: Your backing-up-and-erasing key. Very handy.

               	[image: bullet]	Delete: Also labeled Del and works like Backspace but doesn’t back up to erase. More on that in Chapter 4.

            

            
               Depressing the keys

               When I tell you to “depress the Enter key,” you should look at your keyboard, stare the Enter key squarely in the eye, and say aloud, “You, you funny-looking key. You’re worthless. All the other keys hate you. My right pinky hates you. You’re despised! You should leave the keyboard right now and hide in shame, you worthless key, you!” There, now the Enter key is quite depressed.

               Seriously, you don’t “depress” any key on your keyboard. You press keys. Press them down, and then release them. Any swift tapping motion will do. And the better keyboards pleasingly click for you, making your typing as noisy as it would be on an old manual Olympia.

            

            
               Typing key combinations

               Aside from regular typing, you need to use various key combinations to tell Word how to carry out certain commands. For example:

               Ctrl+P

               Say, “control pee.” That’s the Control+P key combination. Or, if you can palm a basketball in one hand, you can try:

               Ctrl+Shift+F12

               That’s “control shift F twelve.” Both keyboard shortcuts open the Print dialog box — which isn’t really important right now. What is important is what these key combinations tell you to do, namely: Press and hold the Ctrl key while you press P and then release both keys; or press and hold the Ctrl and Shift keys and then press the F12 key. Release all three keys.

               

               
                  [image: Tip]
               

               	Always press and hold the first key (or keys) and then press the last key: Press and release.

               
                  	[image: bullet]	This key combination method works just like pressing Shift+F to get a capital F. It’s the same thing, but with the odd Ctrl (Control) and Alt (Alternate) keys.

                  	[image: bullet]	Yeah, you have to really reach to get some of those key combinations.

                  	[image: bullet]	You don’t need to press hard. If you’re having trouble working a keyboard shortcut, pressing harder doesn’t make the computer think, “Oh, Lordy, she’s pressing really hard now. I think she means it. Wake up, wake up!” A light touch is all that’s required.

               

               

               
                  [image: Remember]
               

               
                  		[image: bullet]	Remember to release the keys: With Ctrl+P, for example, press and hold the Ctrl key, press P, and then release both keys. If you don’t know which one to release first, release the second key and then the Shift key (Shift, Ctrl, Alt) last.

                  	[image: bullet]	Click the Cancel or Close button if you accidentally open the Print dialog box; you can also press the Esc key on the keyboard. See Chapter 9 for more information on canceling printing.

               

            

         

         
            Quitting Word When You’re All Done

            Knowing when to leave is the height of proper etiquette. I typically excuse myself from a party before people start breaking things or setting fire to the furniture. And sometimes it pays to not even show up. But Word cares not for social graces. When the writing is done, or you’re done writing, it’s time to quit Word:

            
               
                  	1.	Choose File
                  ⇒Exit from the menu.

               		This is the standard way to quit any Windows program. 

               
                  	2.	Save any files, if Word prompts you to do so.

               		Word always warns you before it leaves; if you have any unsaved documents, you’re prompted to save them to disk. You see a warning displayed on the screen. If the Office Assistant is visible, it explains the warning in a cartoon bubble, as shown in Figure 1-7.

            

            
               
                  
                     
                        	
                           
                              Figure 1-7: Arf! Arf! Arf!
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               		Click Yes to save your file. You may be asked to give the file a name if you haven’t yet done so. (Chapter 2 tells you how to do this.)

               		If the slop you typed isn’t worth saving, click No.

               		You can click Cancel to “quit” the Exit command and return to Word for more word processing delight.

            

            If you elect to quit, Word leaves the screen, and you return to the Windows desktop, where you can busy yourself with yet another game of FreeCell.

            

            
               [image: Warning(bomb)]
            

            	Do not reset or turn off your computer to quit Word! Doing so can potentially scramble files on your computer’s hard disk. Computers are troublesome enough by themselves. No point in your contributing to that madness by doing something sloppy.

            
               How to quit what you’re doing without quitting Word

               The File⇒Exit command quits any and all Word documents you may be working on. If you merely want to quit a single document and leave others open, or perhaps you merely want to quit what you’re working on and start something new, use the File⇒Close command instead.

               The File⇒Close command closes the document window, making it vanish from the screen. The “white space” in the window disappears. But note that Word does not quit; its toolbars and such are still visible, giving you more options on what to do next.

               
                  	[image: bullet]	Why close a document? Because you’re done working on it! Maybe you want to work on something else or quit Word after closing. The choices are yours, and I explain them in the next chapter.

               

               

               
                  [image: Remember]
               

               
                  		[image: bullet]	Closing a document in Word is similar to ripping a sheet of paper out of your typewriter — but without the satisfying SSHHHHHTHWP! sound it makes.

                  	[image: bullet]	There is no need to close a document, really. In fact, I work on a document over a period of days and keep it open (and my PC on) the entire time. Doesn’t hurt a thing. (I do save it to disk, which is important.)

                  	[image: bullet]	If you try to close a document before it has been saved, Word displays a warning dialog box. Click the Yes button to save your document. If you want to continue editing, click the Cancel button and get back to work.

                  	[image: bullet]	If you’re working on several documents at once, closing one makes another one appear onscreen in place of the document you just closed.

               

            

            
               Starting a new document

               One of the things you can do after closing a document is to start work on a new one. To do this, choose File⇒New, which summons the New Document task pane. From there, click the Blank document item, and you’re ready to start work on something new.

               
                  	

               

               
                  [image: ]
               

               
                  	[image: bullet]	You can also start up a new document quickly by clicking the New Document button on the Standard toolbar.

                  	[image: bullet]	Another thing you can do is to open a document previously saved to disk. You do this with the File⇒Open command, which I introduce in the next chapter.

               

               

               
                  [image: Remember]
               

               
                  		[image: bullet]	You don’t have to quit Word when you just want to start working on a new document.

               

            

         

      

      

   
      
         Chapter 2

         How Most Folks Use Word

         In This Chapter

         
            [image: bullet]	Starting a new document in Word

            [image: bullet]	Typing tips

            [image: bullet]	Formatting

            [image: bullet]	Getting help

            [image: bullet]	Saving your document to disk

            [image: bullet]	Printing

            [image: bullet]	Closing your document

         

         W hen it comes to using Word, most people barely scratch the surface of what it can do. It’s not a bad thing; it’s just that few people dive into the program or are as lucky as you are and have a book to unveil all the secrets. But normally, people use Word like this:

         Imagine these two warriors in full outer space garb, climbing into the cockpit of this fantastic, futuristic spacecraft. They flip buttons, check dials, and punch in codes. They say things like, “Quantum fusion grid, on-line!” and “Check!” and “Enabling anti-gravity proton field” and “Roger.” The ground rumbles, and the incredible machine vibrates with turbines whining and lights blinking. And then: “Engage!” The warriors throttle forward, and the machine lurches 30 feet ahead in a thunderous roar. But then the warriors turn everything off and get out.

         That’s how most people use Word.

         This chapter gives you the basic steps to take as you use Word every day. In fact, if this book were a pamphlet, this chapter would be it. (The rest of the book just offers more details and highly useful information, as well as justification for the hefty cover price.)

         
            Overview (For the Impatient)

            The Word word processing process goes like this:

            
               	
                  1.	Start a new document in Word.

               	
                  2.	Type.

               	
                  3.	Format.

               
                  	4.	Save.

               
                  	5.	Preview.

               
                  	6.	Print.

               
                  	7.	Close.

            

            Everyone follows these steps in one way or another. A good Word user repeats Steps 2, 3, and 4, sometimes varying the order. (Most of the time, you’re typing in Word. Toward the end of the process, you should start formatting, though many people format as they type.)

            If you saved a document earlier and want to work on it again, replace Step 1 with “Open a document on disk.” (See Chapter 8 for more information on the Open command.)

            Steps 5 and 6 are necessary only when you’re done and plan on printing your work. (Chapter 9 discusses Preview and Print.)

            The rest of this chapter elaborates on these steps.

         

         
            Starting a New Document

            When Word starts, it presents you with a blank document, suitable for typing. Your next step, logically, is to type: la-di-da.

            If you need to start a new document while you’re already editing something in Word (such as when you’re writing a letter to a friend and realize that you forgot to type up that urgent business letter), do this:

            
               
                  	1.	Choose File
                  ⇒New from the menu.

               		The New Document task pane appears on the left, giving you a smattering of options for creating a new something or other. What you want is a new document.

               
                  	2.	Click to choose Blank Document.

               		The task pane goes away, and you get your blank page, ready for typing.

            

            	

            
               [image: ]
            

            	A quicker way to do this is to click the New button on the toolbar. That opens a blank page for typing a new document without having to mess with the annoying task pane and its confusing options.

            
               	[image: bullet]	Yes, Word lets you work with more than one document at a time. This is all explained and exploited in Chapter 10.

               	[image: bullet]	Another way to start your work is to open a document on disk (see Chapter 8 for more information). After the document is open, it appears in a window just like any other document you’ve created. Work away!

            

         

         
            Typing (Or Hunting and Pecking)

            Forget all the gizmos and fancy features! Most of your time in Word is spent typing.

            
               
                  Clackity-clack-clack-clack.

            

            Go ahead, type away; let your fingers dance upon the keycaps! What you type appears onscreen, letter for letter — even derogatory stuff about the computer. (Your PC doesn’t care, but that doesn’t mean that Word lacks feelings.)

            New text is inserted right in front of the blinking toothpick cursor. For example, you can type this line:

            

            
               Belching at the table is acceptable.
            

            To change this sentence, move the toothpick cursor to just before the A in acceptable. Use the keyboard’s left-arrow key to move the toothpick cursor back. (Do not use Backspace.) With the toothpick cursor blinking before the A, type the following:

            

            
               un
            

            The new text is inserted as you type, with any existing text being pushed off to the right (even to the next line), happily making room.

            The whole sentence should now read:

            

            
               Belching at the table is unacceptable.
            

            
               	[image: bullet]	Every character key you press on the keyboard produces a character onscreen. This fact holds true for all letter, number, and symbol keys. The other keys, mostly gray on your keyboard, do strange and wonderful things, which the rest of this book tries hard to explain.

            

            

            
               [image: Remember]
            

            
               		[image: bullet]	If you’re a former typewriter user, you’re probably pushing 40! Man, you’re old! Seriously, don’t use the L or I key for a number one or the O (oh) key for a zero in a word processor. This is wrong. Please type 1 for the number one and 0 for the number zero.

               	[image: bullet]	Don’t be afraid to use your keyboard! Word always offers ample warning before anything serious happens. A handy Undo feature recovers anything you accidentally delete; see Chapter 4.

               	[image: bullet]	The Shift key produces capital letters, just like on a typewriter (if you’ve ever used one).

            

            

            
               [image: Tip]
            

            
               		[image: bullet]	The Caps Lock key works like the Shift Lock key on a typewriter. After you press that key, the Caps Lock light on your keyboard comes on, and everything you type is in ALL CAPS.

               	[image: bullet]	Sorry for all the typewriter analogies.

               	[image: bullet]	The number keys on the right side of the keyboard are on the numeric keypad. To use those keys, you must press the Num Lock key, and you see the Num Luck light on the keyboard turn on. When the Num Lock light is off, the number keys serve as duplicate cursor-control, or arrow, keys.

               	[image: bullet]	In some cultures, belching is perfectly acceptable at the table. In fact, it’s considered rude not to belch.

            

            
               When to press that Enter key

               Press the Enter key only when you reach the end of a paragraph.

               Read that again. It’s an admonishment:

               Press the Enter key only when you reach the end of a paragraph!

               [image: Tip]
               
               “Do I need to learn to type?”

               No one needs to learn to type to use a word processor, but you’ll do yourself a favor if you learn. My advice is to get a computer program that teaches you to type. I can recommend the Mavis Beacon Teaches Typing program, even though I don’t get any money from her. I just like the name Mavis, I suppose.

               Knowing how to type makes a painful experience like Word a wee bit more enjoyable.

            

               Unlike plain typing, word processing is about words and paragraphs, not lines of text. It’s important that you tell the word processor where the paragraph ends. The line of text? That’s not a problem: When your typing reaches the right margin on a page, the word processor automatically wraps the text down to the next line. So the only time you need to press the Enter key is at the end of a paragraph.

               For example, type the following text. Just type it all and don’t bother pressing the Enter key, nope, not at all:

               

               
                  We sat silent but eager as we watched Grandma carefully unwrap the present. She 
                  gingerly peeled back the tape and unfolded the wrapper as she always did; a child 
                  of the Great Depression she would save the festive paper and use it again later. 
                  Then she beamed with delight as she beheld her first digital camera. We exploded 
                  in applause! Bill had already set it up, so we all posed and smiled broadly as 
                  Grandma put the camera up to her face and quickly clicked off a photograph of her own nose.
               

               Notice how the text wraps? The last part of the text on the end of one line moves down to the start of the next line. It’s automatic! There’s no “ding!” — nor is there any need to press Enter at the end of the line. Press Enter only at the end of a paragraph.

               
                  	[image: bullet]	The wrapping of text from one line to the next is called word wrap.

                  	[image: bullet]	Some people end a paragraph with two presses of the Enter key; others use only one press. If it’s extra space you want between paragraphs, you should use Word’s paragraph formatting commands, as I describe in Chapter 12 of this book.

                  	[image: bullet]	Double-spacing your lines is also done with a paragraph-formatting command. Do not press Enter if you want double spacing! See Chapter 12 for more information.

                  	[image: bullet]	If you want to indent the next paragraph, press the Tab key after pressing Enter.

               

               

               
                  [image: Tip]
               

               
                  		[image: bullet]	If you press the Enter key in the middle of an existing paragraph, Word splits the paragraph in two, making two new paragraphs. The text above the toothpick cursor becomes its own paragraph, and the text following the toothpick cursor becomes the next paragraph.

                  	[image: bullet]	You can delete the Enter character by using the Backspace or Delete keys. Removing the Enter character joins two paragraphs.

               

            

            
               The lure of the soft return

               

               
                  [image: TechnicalStuff]
               

               	Another way to end a paragraph — but not really end it — is to use the Shift+Enter key combination, also called a soft return or line break. This allows you to end one line of text and start a new line, but without creating a new paragraph. Type this line:

               

               
                  Serving the Hendersons
               

               Now press Shift+Enter. A new line starts. Continue typing:

               

               
                  (Not a cookbook)
               

               Now press the Enter key to end the paragraph.

               All of the text you typed is one paragraph, yet it appears on two lines. That’s the essence of a soft return or line break. Mostly they’re used in titles, headings, or tables, though you may find a purpose for them if you’re creating forms, Web pages, or other documents where such formatting is necessary.

               
                  	[image: bullet]	No, you probably won’t use soft returns as much as you use real returns (also called hard returns, coincidentally).

                  	[image: bullet]	See Chapter 20 for moron tables — I mean more on tables.

               

            

            
               When to whack the spacebar

               You use the spacebar to insert spaces between words or sentences. Withoutityourtextwouldbehardtoread.

               In Word, as in all typing you do on a computer, you put only one space between sentences. (If you’re a touch-typist, this habit is tough to break, but it’s possible.)

               The only peeve I have about the spacebar is that too often folks use spaces to line up columns of information or to indent. This is terribly wrong, and, as those folks discover, the output on paper looks tawdry. Yes, cheap and tawdry.

               

               
                  [image: Tip]
               

               	Rather than use the spacebar to indent or line up text, use the Tab key. The Tab key is the best way to organize information on the screen. Unlike the spacebar, the Tab key indents text to an exact position so that when you print, everything lines up nice and neatly. (See Chapter 13 for more Tabby information.)

               
                  	[image: bullet]	Use that spacebar to put a single space between words and sentences.

               

               

               
                  [image: Remember]
               

               
                  		[image: bullet]	One space between sentences is all you need. Whenever you feel like using more than one space, such as arranging text in columns or lining things up, use a Tab instead (see Chapter 13).

                  	[image: bullet]	I hear that typing teachers still tell students to put two spaces between sentences. Well, guess what? They’re wrong!

                  	[image: bullet]	The Romans couldn’t put spaces between words carved on buildings because the Chiselers Union didn’t know how to charge for it.

               

            

            
               Things to notice whilst you type

               Lots of interesting things go on while you type, some of which may puzzle you, others of which may annoy you, and a few that may cause you undue consternation.

               
                  The status bar

                  The first thing to notice while you type is the status bar at the bottom of the screen. The information there tells you something about your document and where you’re typing in it. Figure 2-1 explains everything, although the only items I refer to are the Page (current page you’re editing), and the total pages in the document (the last number in item C in Figure 2-1).

                  
                     
                        
                           
                              	
                                 
                                    Figure 2-1: Secrets of the status bar.

                              
                              	
                                 [image: Figure 2-1: Secrets of the status bar.]
                              
                           

                        
                     

                  

               

               
                  Life between pages

                  Word likes to show you where one page ends and another begins. This is a good thing to know because most of what you create ends up on a sheet of paper — or maybe two sheets, but you wanted only one. In that case, you can always use the status bar (refer to Figure 2-1) to see how many pages you have or which page you’re on. But Word has visual methods as well.

                  Word uses two visual clues to show you where a new page happens, depending on which view you’re using to see your document.

                  If you choose View⇒Print Layout (the way Word naturally looks), the break between pages shows up on the screen in a virtual manner. Figure 2-2 shows the details. The pages are white, and the space between them is gray.

                  
                     
                        
                           
                              	
                                 
                                    Figure 2-2:  A page break in Print Layout view.

                              
                              	
                                 [image: Figure 2-2: A page break in Print Layout view.]
                              
                           

                        
                     

                  

                  If you choose View⇒Normal, which is how I use Word, the break between pages shows up as a line of ants marching across the screen. Don’t spray ’em with bug killer!
                  

                  
                     [image: ]
                  

                  

                  That thing (shown above) is a Normal view page break. The text you see above the ants, er, dots, is on the preceding page; text below the dots is on the next page.

                  
                     	[image: bullet]	You cannot delete this type of page break. You can change where it happens, but if your text is too long for the page, Word automatically places it on the next page.

                     	[image: bullet]	A row of dots close together — very friendly ants — marks a hard page break. The words Page Break even appear right in the middle of the line. This on-purpose page break is covered in Chapter 14.

                  

               

               
                  Spots between words!

                  There is no cause for alarm if you see spots — or dots — onscreen when you press the spacebar or Enter key — like this:

                  

                  
                     This•can•be•very•annoying.¶
                  

                  [image: Tip]
               
                  Ridding your document of that final, blank page

                  One common problem many Word users have is that Word tells them their document is one page longer than it should be, and that final page is blank. To remove that trailing blank page, do this: Press Ctrl+End, which moves the toothpick cursor all the way to the very bottom of your document, onto that last page. Then, carefully, keep pressing the Backspace key until that final blank page is gone. That will do it!

               

                  What’s happening is that Word is showing you the nonprinting characters. Word uses various symbols to represent things you normally wouldn’t see: spaces, tabs, and the Enter key.

                  Why bother? By displaying the nonprinting characters, you can easily find things that may be screwing up your text formatting but otherwise would be hard to see. For example, two tabs in a row may suddenly jerk your text around as you’re editing. The only way to know that there are two tabs in a row would be to view the nonprinting characters.

                  
                     	[image: bullet]	To turn the nonprinting characters off, press the Ctrl+Shift+8 key combination. (Press it again to turn them on, if you’re curious.) Use the 8 on the keyboard, not on the numeric keypad.

                     	

                  

                  
                     [image: ]
                  

                  
                     	[image: bullet]	You can also click the Show/Hide button on the Standard toolbar to display or hide the nonprinting characters.

                     	[image: bullet]	The symbols show up onscreen but — fortunately — not in a printed document.

                  

               

               
                  Underline squiggly wigglies

                  Adding underline to your text in Word is cinchy; Chapter 11 tells you all about it. Yet, there are times when Word may do some underlining by itself, with red, green, and purple underlines of zigzag and dotted styles. What Word is doing is alerting you to certain special things about that underlined text.

                  Spelling errors in Word are underlined with a red zigzag. That’s Word’s annoying real-time spell checker in action. It’s saying, “Hmmm! I’m not sure about the spelling of this red underlined word!”

                  Grammatical errors in Word are underlined with a green zigzag. Word is telling you that some English-language sin has been committed. (Relax, it’s usually wrong.)

                  The dotted purple underline is used in Word as a smart tag. That flags a potential contact person, date, or place that you may want to share with Microsoft Office and the Outlook program.

                  Generally speaking, ignore all squiggly lines until you move into the editing phase for your document. (Well, unless you become obsessive, but that tends to slow down the writing process.)

                  
                     	[image: bullet]	Refer to Chapter 7 for more information on fixing spelling and grammar errors in Word — and for turning the zigzag line feature off, if you’re so inclined.

                     	[image: bullet]	Chapter 34 explains all you need to know about Smart Tags, including how to turn them off.

                  

               

               
                  Watch the Office Assistant!

                  	

                  
                     [image: ]
                  

                  	As you type, the Office Assistant does various interesting things, which you may find amusing. In fact, if you wait too long while reading or composing your thoughts, you may notice the Office Assistant going to sleep (see the dog in the margin). That’s a good clue that you should stop staring off into space and get back to work!

               

            

            
               “Oops! I made a boo-boo!”

               If you make a mistake, press the Backspace key to back up and erase. This key is named Backspace on your keyboard, or it may have a long, left-pointing arrow on it: ←.

               

               
                  [image: Warning(bomb)]
               

               	Pressing and holding down the Backspace key puts you in Rapid Consumption mode — a whole lotta characters to the left of the blinking toothpick cursor are erased — until you release the Backspace key.

               The Delete key also gobbles characters, though it deletes the character to the right of the blinking toothpick cursor.

               

               
                  [image: Tip]
               

               	For even larger boo-boos (booboous maximus), Word has an Undo key. It doesn’t erase text, but it helps you yank back text you accidentally erase. See Chapter 4 for more Undo information.

            

         

         
            Formatting Your Document

            Formatting is what makes your document look professional and not like it came from an abused typewriter at the public library. You can format several things in your document:

            
               	[image: bullet]	Characters

               	[image: bullet]	Paragraphs

               	[image: bullet]	Tabs

               	[image: bullet]	The entire document

               	[image: bullet]	Pages

               	[image: bullet]	Columns

               	[image: bullet]	Headers and footers

            

            Your primary duty in word processing is to get down the text. After that, you typically go back and format, changing the text style or adjusting the margins. This is all covered in Part II of this book.

            
               	[image: bullet]	Word can format your document for you. I describe how in Chapter 18.

               	[image: bullet]	Most folks format text as they type, adding italics or bold or whatever. You can also format paragraphs as you write, although some major formatting chores are best done after you write your text. (Examples of both techniques are shown in Part II.)

               	[image: bullet]	Word also lets you format your document by adding drawings, pictures, lines, tables, columns, or other elements that can really make things look snazzy. Parts III and V cover those topics.

            

         

         
            Getting Help

            You can get help for just about anything by pressing the F1 key. This key presents the Microsoft Word Help task pane, which you can use for help. You can either type in a phrase or question to search for an answer or click a Table of Contents link to view Word’s enormous and confusing online manual. Pick your torture!

            You can also venture out to Microsoft.com on the Internet and look for on-line assistance or training. But you have this book, and it should help you with most of the general chores; no point in wasting time (and money) trying to pinch that information out of Microsoft.

            Another way to get help is to use the Office Assistant (if it’s visible). Clicking the mouse on the Office Assistant displays a cartoon bubble over his head, asking, “What would you like to do?” Type in your question, as shown in Figure 2-3. Press the Enter key, and the dog answers your question:

            
               
                  Bark! Woof! Woof! Woooooooff!

            

            
               
                  
                     
                        	
                           
                              Figure 2-3: The Office Assistant is ready to help.

                        
                        	
                           [image: Figure 2-3: The Office Assistant is ready to help.]
                        
                     

                  
               

            

            Seriously, the Office Assistant goes out and tries to find help, the results of which appear in the task pane in a few connecting-to-the-Internet moments. You can then click to choose an item to read and, gods willing, it will actually be helpful.

         

         
            Save Your Stuff!

            The computer is dumb. The computer is forgetful. And it loses things. To help the computer remember, you must tell it to save your stuff. Everything you create in Word should be saved to disk, stored there as a document.

            	

            
               [image: ]
            

            	To save a document to disk, choose the File⇒Save command (or press Alt+F, S). (You can also click the Save button, which looks like a wee li’l disk, on the Standard toolbar.)

            If you’re saving your document for the first time, the Save As dialog box appears, as shown in Figure 2-4.

            
               
                  
                     
                        	
                           
                              Figure 2-4: The Save As dialog box.

                        
                        	
                           [image: Figure 2-4: The Save As dialog box.]
                        
                     

                  
               

            

            Type a name for your document in the File Name area. The name The Forest is shown in Figure 2-4. If you make a mistake typing, use the Backspace key to back up and erase.

            Click the Save button to save your document.

            
               	[image: bullet]	Chapter 8 offers more details about saving your document.

               	[image: bullet]	The filename is how you recognize the file later, when you want to edit or print it again. It’s important to think up and use a good, descriptive filename.

            

            

            
               [image: Tip]
            

            
               		[image: bullet]	The fastest way to save a file is to use the keyboard. The Save File key combination is Ctrl+S. Press and hold the Ctrl (Control) key and press the S key. If you can pick up a basketball with one hand, you can also use the Shift+F12 key combo.

               	[image: bullet]	When you save a document, watch the status bar — it temporarily displays a message telling you that Word is saving your document (or fast saving, for our Frequent Fliers).

               	[image: bullet]	You can generally name a file anything, however Word (or the Office Assistant) tells you when you enter a forbidden filename. Click OK and try again.

               	[image: bullet]	After the document is saved to disk, you see its name displayed on the window’s title bar. That name is your clue that your document has been saved to disk.

            

            

            
               [image: Warning(bomb)]
            

            
               		[image: bullet]	If you’re not in a clever mood, you may decide to name your file with the name of a file already on disk. This decision is a boo-boo because the newer file overwrites the other file with the same name already on disk. For example, if you decide to save your new letter by using the LETTER filename and LETTER already exists on disk, the new file overwrites the old one. There is no way to get the original back, so use another, more clever name instead. You’re warned with this message:

            

            

            
               The file 
               filename
                already exists.
            

            
               		Click Cancel or choose the option to save the file to disk with a different name. Start over.

            

         

         
            Getting It Down on Paper (Printing)

            The great authors didn’t worry about printing. Shakespeare never had to save his document or use Print Preview. Poe wrote The Raven on paper, so “printing” was what he did as he wrote. And Mark Twain, who wrote The Adventures of Tom Sawyer on that newfangled typewriter, well, he was pretty high tech. And you?

            Printing is the result of your word processing labors. Hercules? He had to retrieve some gal’s girdle. You? You have to print your document. Everything looks nice and tidy on paper — almost professional.

            
               First, preview your printing

               	

               
                  [image: ]
               

               	To see what your document will look like without wasting valuable paper, use the Print Preview command. Choose File⇒Print Preview or click the handy Print Preview button on the toolbar.

               Figure 2-5 shows you what Print Preview mode looks like. Your document is shown exactly as it will print, including any pictures, headers, or footers or other items that may not show up properly when you’re editing.

               	

               
                  [image: ]
               

               	Okay. It looks good. Click the Close Preview button to return to your document for editing or printing.

            

            
               Time to print

               To print your document in Word — the document you see onscreen, all of it — do the following:

               
                  
                     	1.	Make sure that your printer is on and ready to print.

                  		See Chapter 9 for additional information about preparing the printer if you need to.

                  
                     	2.	Choose the File
                     ⇒Print command.

                  		The Print dialog box opens. This is a busy place where printing and related activities happen.

                  
                     	3.	Click the OK button.

                  		The document comes out of your printer.

                  	[image: bullet]	You can also summon the Print dialog box by pressing Alt+F, P, or Ctrl+P. This method is more desirable if you have long fingers or do needlepoint or if the mouse is off eating the cheese again.

                  	[image: bullet]	Notice that saving comes before printing. It doesn’t have to, but I’m a stickler for saving, saving, saving your document.

               

               
                  
                     
                        
                           	
                              
                                 Figure 2-5: Print Preview mode.

                           
                           	
                              [image: Figure 2-5: Print Preview mode.]
                           
                        

                     
                  

               

            

         

         
            Close ’Er Up

            To close a document when you’re done, choose the File⇒Close command (Ctrl+W). This step closes the document window and makes it vanish from the screen. Zzzipp! (You have to say “Zzzipp!” when you do this; Word is strangely mute on the point.) This step is covered succinctly in Chapter 1; for all the details, see the section about how to quit what you’re doing without quitting Word.

            
               	[image: bullet]	Why close a document? Because you’re done working on it! Maybe you want to work on something else or quit Word after closing. The choices are yours.

               	[image: bullet]	If you try to close a document before it has been saved, Word displays a warning dialog box. Click the Yes button to save your document. If you want to continue editing, click the Cancel button and get back to work.

               	[image: bullet]	If you’re working on only one document and you close it, Word looks like it has vacated the premises: Toolbars and menus dim, as do scroll bars and other screen debris. Don’t panic; you’ve just closed a document, and Word has little else to do. Word sits patiently and waits for your next command.

               	[image: bullet]	If you’re done with Word, quit. Otherwise, you can start working on another document. Refer to “Starting a New Document,” earlier in this chapter.

            

         

      

      

   
      
         Chapter 3

         Basic Movement

         In This Chapter

         
            [image: bullet]	Moving the toothpick cursor

            [image: bullet]	Using key combinations to move up, down, to the top, to the bottom — you get the idea

            [image: bullet]	Using the Go To command

            [image: bullet]	Bookmarking memorable bits o’ text

            [image: bullet]	Using the secret scroll bar buttons

            
               
            

         

         
            Once upon a midnight dreary, while I pondered, weak and weary, blaring from the TV bleary comes another infomercial leery.
         

         W riting means rewriting, which means that there will be times when you’re just perusing your document, up and down. If you need a mental image, picture a typewriter with only one long sheet of paper — like a scroll. To reread your document, you would have to rewind or “scroll” it back through the platen until you found the part you wanted. Ugh. What a chore!

         Fortunately, Word has some basic toothpick cursor movement commands that let you scroll, read, or edit through your document much easier than cranking a knob. It’s all about movement! Exercise! Be active! Avoid late night TV!

         
            Moving around Your Document

            When you scribble on a pad of paper, it’s hard to lose your place. And in the old typewriter days, a page of paper was only so big. But with Word, your documents can be downright humongous. Unfortunately, only a small part of that humongousness appears on your computer screen at a time. To get from one place to another, you need to do more than just press the arrow keys. You need to find out about Word’s navigation keys and other special commands you can use to get around in your document.

            
               Going hither, thither, and yon (basic arrow keys)

               The most common way to move about in your document is to press the arrow keys, which are also called the cursor-control keys because they control the toothpick cursor onscreen. These keys can be used alone or with other keys on your keyboard to zippity-zap the toothpick cursor all over your document.

               

               
                  [image: Warning(bomb)]
               

               	If you use the arrow keys on the numeric keypad, make sure that the Num Lock light is off. Do this by pressing the Num Lock key. If you don’t do this, you see numbers in your text rather than the toothpick cursor dancing all over — like444this.

               The four basic arrow keys move the toothpick cursor up, down, right, and left:

               
                  
                     
                        
                           	Key	
                           	What It Does
                           	
                        

                     
                     
                        
                           	↑	
                           	Moves the cursor up to the preceding line of text
                           	
                        

                        
                           	↓	
                           	Moves the cursor down to the next line of text
                           	
                        

                        
                           	→	
                           	Moves the cursor right to the next character
                           	
                        

                        
                           	←	
                           	Moves the cursor left to the preceding character
                           	
                        

                     
                  

               

               If you press and hold the Ctrl (Control) key and then press an arrow key, you enter afterburner mode. The supercharged toothpick cursor jumps in desperately quick leaps in all four directions:

               
                  
                     
                        
                           	Press These Keys	
                           	To Do This
                           	
                        

                     
                     
                        
                           	Ctrl+↑	
                           	Moves the cursor up to the start of the previous  
                           	
                        

                        
                           		
                           	paragraph
                           	
                        

                        
                           	Ctrl+↓	
                           	Moves the cursor down to the start of the next paragraph
                           	
                        

                        
                           	Ctrl+→	
                           	Moves the cursor right to the start (first letter) of the 	
                           	
                        

                        
                           		
                           	next word
                           	
                        

                        
                           	Ctrl+←	
                           	Moves the cursor left to the start (first letter) of the  
                           	
                        

                        
                           		
                           	previous word
                           	
                        

                     
                  

               

               Use the Ctrl key with the arrow key in the same way that you use the Shift key with the s key to get a capital S: Press and hold the Ctrl key and then press an arrow key. Release both keys. You don’t have to press hard.

               
                  	[image: bullet]	You cannot move the toothpick cursor beyond the limits of your document: You cannot scroll “higher” than the first line or “lower” than the last line of a document, nor can you attempt to place the cursor in the nether regions between pages by clicking your mouse.

                  	[image: bullet]	If you like, you can direct Word to beep at you when you try to move the cursor beyond the limits of a document: Choose Tools⇒Options from the menu. Click the General tab in the Options dialog box, and put a check mark by the item Provide Feedback with Sound. Click OK, and follow the directions on the screen. When it’s all set up, Word cacophonously beeps when you attempt to force the toothpick cursor off the page.

               

               

               
                  [image: Remember]
               

               
                  		[image: bullet]	Moving the cursor does not erase characters; using the Backspace and Delete keys erases characters (among other things discussed in Chapter 4).

                  	[image: bullet]	The word yon was used in English as another form of the word there. Here is here, there is there, and yon is like there, but farther off. It’s short for yonder.

               

            

            
               Making that toothpick cursor skedaddle (moving by great leaps and bounds)

               Not all your fingers are the same length. Look at them right now! See how some are shorter and some are longer? The short ones are probably that way because you press the arrow keys on your keyboard in an improper manner. For shame. There are better ways to jump around a document.

               Instead of woodpeckering your keyboard, try using some of the arrow key (and non-arrow key) combinations in the following sections to really make that toothpick cursor fly around your document.

               
                  Paging Mr. PgUp and Mr. PgDn!

                  PgUp is keyboard language for Page Up. And PgDn is keyboard language for Page Down. Your keyboard has both sets of keys: keyboard language PgUp and PgDn on the numeric keypad, and Page Up and Page Down on the cursor area (to the left of the keypad). Isn’t that nice?

                  One would think, logically, that the Page Up set of keys moves a document up one page and that the Page Down set of keys moves a document down. ’Tain’t so, though. Rather than slide your document around a page at a time, these keys move things one screen at a time:

                  
                     PgUp	The PgUp key moves the toothpick cursor up one screen. Or, if you’re at the tippy-top of your document, this key moves you to the top of the screen.

                     PgDn	Moves the cursor down one screen or to the end of the document, if you happen to be there, or to the end of the document if you happen to be less than a screen away.

                  

                  As with the regular cursor movement keys (arrow keys), you can combine Mr. PgUp and Mr. PgDn with the Ctrl key for some interesting leaps and bounds:

                  
                     Ctrl+PgUp	With the Ctrl key pressed, the PgUp key actually does move to the top of the page in your document. You’ll have to view the status bar (near the bottom of the window) to confirm this. Press Ctrl+PgUp again to move to the top of the previous page.

                     Ctrl+PgDn	When combined with the Ctrl key, the PgDn key moves the toothpick cursor to the top of the next page.

                  

                  Note that you can change the function of the Ctrl+PgUp and Ctrl+PgDn keys. Normally they do leap around by full pages. I describe how to change this later in this chapter.

                  Finally, here are two more key combinations that are just this side of pressing all the keys on the keyboard at once:

                  
                     Ctrl+Alt+PgUp	Moves the cursor to the top of the current screen.

                     Ctrl+Alt+PgDn	Moves the cursor to the bottom of the current screen.

                  

                  Personally, I’ve never used those keys because it’s just easier to click the mouse wherever I want to put the toothpick cursor.

                  

                  
                     [image: TechnicalStuff]
                  

                  	There is no logic in the computer industry.

               

               
                  Beginnings and endings

                  Up/down, top/bottom, begin/end — sometimes you just need to get right there. These are the keys that do it — and they’re named surprisingly well:

                  
                     
                        
                           
                              	Key or Combination	
                              	Where It Puts Your Cursor
                           

                        
                        
                           
                              	End	
                              	This key sends the toothpick cursor to the end of a 	
                           

                           
                              		
                              	line of text.
                           

                           
                              	Home	
                              	This key sends the toothpick cursor to the start of a 	
                           

                           
                              		
                              	line of text.
                           

                           
                              	Ctrl+End	
                              	This key combination whisks the toothpick cursor to 	
                           

                           
                              		
                              	the very, very end of your document.
                           

                           
                              	Ctrl+Home	
                              	This key combination takes you to the tippy-top of 	
                           

                           
                              		
                              	your document. Zoom!
                           

                        
                     

                  

                  

                  
                     [image: Warning(bomb)]
                  

                  	Ctrl+End is an easy key combination to mistakenly press. It throws you — literally — to the end of your document. If you do this and feel that you have boo-booed, press Shift+F5, the Go Back keyboard shortcut, to return from whence you came (that is, back to your previous edit). Also see “Going Back,” later in this chapter.

               

            

            
               Using the mouse to move yerself around

               The mouse provides a quick and easy way to move the toothpick cursor: First, spy a new location for the cursor onscreen. Then move the mouse pointer to where you want the cursor to be and click. The cursor relocates there instantly. It’s point and click.

               You can also use your mouse to manipulate the vertical scroll bar (to the right of the document window). The scroll bar is a standard Windows toy, working in Word like it does in all of Windows. The only bonus you get here is that if you drag the elevator button with the mouse, you see a pop-up balloon telling you approximately which page you’re dragging to in your document, as shown in Figure 3-1. You might even see the current part heading or chapter title as you drag the elevator button.

               
                  
                     
                        
                           	
                              
                                 Figure 3-1: Vital page-numbering information.

                           
                           	
                              [image: Figure 3-1: Vital page-numbering information.]
                           
                        

                     
                  

               

               Finally, if your PC sports one of the new “wheel” mice, such as the Microsoft IntelliMouse, you can scroll through your document using the center wheel button:

               Roll the wheel up or down to scroll your document up or down. (You use  the Mouse icon in the Windows Control Panel to set the number of lines the document scrolls.)

               Click the wheel to exert super-mousian control over the vertical scroll bar to quickly scroll your document up and down.

               Press the wheel like a button and drag the mouse to smoothly scroll up and down or “pan” your document from left to right.

               Oh, I just love those mouse toys!

               

               
                  [image: Warning(bomb)]
               

               
                  		[image: bullet]	Watch out when you’re using the vertical scroll bar to move around your document! Scrolling the screen does not make the cursor flippity-jibbit all over. You must click the mouse in the text to actually move the cursor to a given spot. So, for example, you may scroll to view page 5, but the toothpick cursor is still a-blinkin’ on page 3. When you start to type, the new text appears on page 3 where the toothpick cursor is, not on page 5 where you’re looking.

                  	[image: bullet]	You must click the mouse to move the cursor to that spot. If you don’t click the mouse, you’re just messing with the computer’s mind.

               

            

         

         
            Going Here or There with the Go To Command

            Go To, as in the Shakespearean “Getteth thee outta hereth,” enables you to go directly to just about wherever in the document you want to be. The Go To command lets you find a specific page number, line, or what-have-you in your document.

            To use the Go To command, choose Edit⇒Go To, and the Go To tab in the Find and Replace dialog box appeareth before thine eyes (see Figure 3-2).

            You can go to lots of places, as the confusing items in the Go To What list in Figure 3-2 demonstrate. Usually, though, you want to go to a specific page number.

            Type a page number into the Enter Page Number box.

            
               
                  
                     
                        	
                           
                              Figure 3-2: Tell ’em where to  go on the  Go To tab.

                        
                        	
                           [image: Figure 3-2: Tell ’em where to go on the Go To tab.]
                        
                     

                  
               

            

            For example, type 14 in the box and press Enter, and you go to page 14. That’s supposing you have a page 14 to go to.

            
               	[image: bullet]	You can also press the F5 key to open the Go To tab in the Find and Replace dialog box.

               	[image: bullet]	Heck, you can also press the Ctrl+G keyboard shortcut. (Makes more sense than F5, anyway.)

               	[image: bullet]	If you click twice on the page number on the status bar (muttering “Change, you idiot — change, change,” while you do this helps), the Go To dialog box appears like a genie out of a lamp.

               	[image: bullet]	To be even more specific in your Go To commands, see “Don’t Dog-Ear Your Monitor! Use the Bookmark Command,” just ahead in this chapter.

            

         

         
            Going Back

            They say that once you commit, there’s no going back. That is, unless you’re running for office or using Word. If you go anywhere you don’t want to be, press Shift+F5, and Word carries you back to where you started.

            The Shift+F5 keyboard shortcut works only in Word; you can’t use this command in real life.

            

            
               [image: Tip]
            

            	Pressing Shift+F5 returns you to where you were before; pressing it again takes you back to where you were before that. This keyboard shortcut works about three times before it starts repeating itself. Repeating itself. Repeating itself.

         

         
            Don’t Dog-Ear Your Monitor! Use the Bookmark Command

            As the scatterbrained type, I often find myself working on several parts of a document at once. Maybe you do that, too. Or perhaps you’re reading what you wrote and need to remember a specific spot to come back to. Whatever the reason, often it’s necessary to, well, put a bookmark in your document. That’s tough to do without bending the corner of your monitor, which I doubt would work anyway.

            Welcome to Word’s Bookmark command.

            
               Setting a bookmark

               To mark your place in your document, set a bookmark. Follow these steps:

               
                  
                     	1.	Put the toothpick cursor where you want to place a bookmark.

                  
                     	2.	Choose the Insert
                     ⇒Bookmark command (or, if you have three hands, try Ctrl+Shift+F5).

                  		The Bookmark dialog box opens, as shown in Figure 3-3.

               

               
                  
                     
                        
                           	
                              
                                 Figure 3-3: The Bookmark dialog box.

                           
                           	
                              [image: Figure 3-3: The Bookmark dialog box.]
                           
                        

                     
                  

               

               
                  
                     	3.	Type a name for the bookmark.

                  		Be clever! The name reminds you of where you are in your document. So if you’re creating a term paper, memorable flags for various parts of your document (and their original sources) would be proper.

               

               

               
                  [image: Warning(bomb)]
               

               
                  			Bookmark names cannot contain spaces. However, you can use underlines to separate words, as shown in Figure 3-3.

                  
                     	4.	Press Enter or click the Add button.

               

            

            
               Finding a bookmark and moving to that spot in your document

               To return to a bookmark, use the Go To command, as covered in “Going Here or There with the Go To Command,” earlier in this chapter. These steps keep you from turning the page and losing your train of thought:

               
                  
                     	1.	Press the F5 key.

                  		The Find and Replace dialog box splats across your screen.

                  
                     	2.	Highlight Bookmark on the Go To What list.

                  		Bookmark is the fourth item down.

                  		The Enter Page Number box changes to read Enter Bookmark Name. Your most recent bookmark appears in that space.

                  		If you don’t see your bookmark, click the down arrow, and you see a long list of bookmarks in your document. Click the one you want.

                  
                     	3.	Click the Go To button.

                  		You’re there!

                  
                     	4.	Click the Close button to get rid of the Find and Replace dialog box and return to editing your document.

               

            

         

         
            Using Secret Scroll Bar Buttons to Navigate

            Lurking at the bottom of the vertical scroll bar are three buttons, as shown in the margin. These are the browse buttons, which allow you to scroll through your document in leaps and bounds of various sizes.

            	

            
               [image: ]
            

            	The top button is the Browse Up button.

            	

            
               [image: ]
            

            	The bottom button is the Browse Down button.

            	

            
               [image: ]
            

            	And the center button is the What The Heck Am I Browsing For? button.

            When you click the center button, a pop-up palette of things to browse for appears, as shown in Figure 3-4. Pointing the mouse at any one of the items displays text that explains the item in the bottom part of the palette.

            
               
                  
                     
                        	
                           
                              Figure 3-4: Various things to browse for.

                        
                        	
                           [image: Figure 3-4: Various things to browse for.]
                        
                     

                  
               

            

            
               	[image: bullet]	Choosing an item from the palette controls how the browse buttons work.

               	[image: bullet]	The Ctrl+PgUp key combination is linked to the Browse Up button.

               	[image: bullet]	The Ctrl+PgDn key combination is linked to the Browse Down button.

            

            
               How the secret scroll buttons work

               	

               
                  [image: ]
               

               	Unless you’ve chosen another item from the browsing palette (refer to Figure 3-4), the Browse buttons (and Ctrl+PgUp, Ctrl+PgDn) leap through your document by full pages.

               Whenever an option other than Page is chosen, the Browse buttons change color. So when the buttons are black, you know you’re browsing by page. But if they turn blue, then the Browse buttons are searching for something else. (Alas, the browsing palette doesn’t tell you which option is currently chosen.)

               	

               
                  [image: ]
               

               	A handier item to choose is to browse by edits. If you select the Browse by Edits button from the palette, then you can use the Browse Up or Browse Down buttons to leap through your document and review the three most recent places where you’ve edited text. This comes in very handy for when you screw things up.

            

            
               Using the buttons with the Find command

               	

               
                  [image: ]
               

               	The Browse buttons are also related to the Find command (covered in Chapter 5). When you choose the Find option, clicking the Browse Up or Browse Down button locates the last item you’ve searched for.

               For example, you use the Find command to locate some bit of text. After that, you can choose the Find button from the browsing palette (refer to Figure 3-4) and use the Browse arrows to continue searching for that text without having to resummon the Search dialog box. Very handy.

            

         

      

      

   


End of sample
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30 minutes later and the entire Emergency room knew that I was going to be a difficult
patient.
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